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 CONTACT DETAILS OF SUBMITTING BODY 
 

Name and address of submitting body: 
 

 NIELIT Gorakhpur, 

M.M.M.U.T. Campus, Deoria Road Gorakhpur – 273010 (UP) 

Phone No.: 0551-2273371 

Branch Office 

 NIELIT Lucknow 

A-1/9, Sumit Complex, VibhutiKhand, Gomti Nagar, Lucknow- 226010(UP) 

Phone No.: 0522 272 0590 

Name and contact details of individual dealing with the submission 

Name: Vijai Shankar Jaiswal 

Position in the organisation Dy. Dir.(T) 

Address if different from above As above 

Tel number(s) 0522-2720590 

E-mail address vsjaiswal@nielit.gov.in 

 
 

List of documents submitted in support of the Qualifications File 

1. Detailed Curriculum 

2. Annexure 1`Lesson Plan 

3. Annexure 2 Trainers Details 

https://www.google.co.in/search?biw=1366&bih=643&q=national%2Binstitute%2Bof%2Belectronics%2Band%2Binformation%2Btechnology%2Bphone&stick=H4sIAAAAAAAAAOPgE-LRT9c3LCgwKsvKMTLT0s9OttJPzs_JSU0uyczP08_Oyy_PSU1JT40vSMxLzSnWz0gsji_IyM9LtQKTAFdjqSNBAAAA&sa=X&sqi=2&ved=0ahUKEwjnh72H1szOAhUGuo8KHa76BtUQ6BMIhAEwDw
https://www.google.co.in/search?biw=1366&bih=643&q=national%2Binstitute%2Bof%2Belectronics%2Band%2Binformation%2Btechnology%2Bphone&stick=H4sIAAAAAAAAAOPgE-LRT9c3LCgwKsvKMTLT0s9OttJPzs_JSU0uyczP08_Oyy_PSU1JT40vSMxLzSnWz0gsji_IyM9LtQKTAFdjqSNBAAAA&sa=X&sqi=2&ved=0ahUKEwjnh72H1szOAhUGuo8KHa76BtUQ6BMIhAEwDw
mailto:vsjaiswal@nielit.gov.in
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 QUALIFICATION FILE SUMMARY 
 

Qualification Title Advance Diploma in Computer Application Accounting and 

Publishing 

Qualification Code 
NIELIT/OA/4/40 

NCO Code and Occupation 
3512.0200 
Desk Top Publishing Operator 

Nature and Purpose of 

Qualification 

Create Skilled Man Force for Computer Application 
Accountingand Publishing, candidates can be easily 
absorbed in any publishing house or press. 

Body/bodies which will 

award the qualification. 

Certification Division, 
National Institute of Electronics and Information Technology 

NIELIT Bhawan , Plot No.3, PSP Pocket, Sector-8, 
Dwarka,New Delhi-110077 

Body which will accredit 

providers to offer the 

qualification. 

Accreditation Division, 
National Institute of Electronics and Information Technology 

NIELIT Bhawan , Plot No.3, PSP Pocket, Sector-8, 

Dwarka,New Delhi-110077 

Presently, Accreditation is not prescribed; affiliation is one 

of the models. 

Occupation(s) to which the 

qualification gives access 

Office Assistant, Desktop Publisher, Account Assistant, 

Technical Assistant. 

Can start their own Small Scale business and can be self 

employed 

Job description of the 

occupation 
 Office Assistant, Desktop Publisher, Account 

Assistant,Technical Assistant 

 Can Work In Call Centre for After Sale Support -  

can be also absorbed in Local Markets 

 Can start their own Small Scale business and can  

be self employed 

Licensing requirement Nil 

Statutory and Regulatory 

requirement of the relevant 

sector(documentary evidence 
to be provided) 

Nil 

Level of the qualification in 

the NSQF. 

4 

Anticipated volume of 

training/learning required to 

complete the qualification 

200 Hrs. 

Indicative list of training 

tools required to deliver this 

qualification 

Recommended hardware/software tools: 

Hardware 

We required following hardware for smooth 
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functioning of training program:- 

 Processor: Core-2 or Above 

 Memory: Min. 2 GB RAM 

 Disk space: Min. 160 GB 

 UPS 

 Printer 

Software 

This course required following software:- 

 Microsoft-Office, Tally .ERP 9 

 Concepts of Image Editing & 

Advertising- Adobe InDesign, Adobe 

Photoshop 

 Graphics Designing - Corel Draw, 

Adobe Flash 

 
Here is list of additional software required for 

computer:- 

 Windows 7 or Above 
 Antivirus latest 

Entry requirements / 

recommendations. And 

minimum age 

Intermediate (10th +2)   

Progression from the 

qualification. 

Office Assistant Technical Assistant Account Assistant 

Desktop Publisher 

Planned arrangements for 

RPL. 

Yes. The RPL will be carried out through screening, 

identifying the skill gaps, provide bridge training to cover 

the competency gap & then conduct final assessments of the 

candidates 

International comparabilityNo 

Date of planned review of qualification After Every Two Year 

Formal structure of the qualification 

Mandatory components 

Title of component and 

Identificationcode/NOSs/Learning outcomes 

Estimated 

size 

(learning 

hours) 

 

Level 

Understanding Computer fundamental and office automation software 50  

 

4 Introduction To Financial Accounting 50 

Preparation of Account Books Using Accounting Packages 50 
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Working with Desktop Publishing Softwares 50  

 Sub Total (A) 200  

Optional components 

Title of component and 

identificationcode/NOSs/Learning outcomes 

Estimated 

size 

(learning 

hours) 

 

Level 

    

    

 Sub Total (B) 0  

 Total (A+B) 200  

 

Please attach any document giving further detail about the structure of the qualification – eg a 

Curriculum or Qualification Pack.Nil 

 

SECTION 1 

ASSESSMENT 

Body/Bodies which will carry out assessment: 

Examination Cell, 

National Institute of Electronics and Information Technology 
NIELIT Bhawan , Plot No.3, PSP Pocket, 
Sector-8, Dwarka, New Delhi-110077 

 

How will the assessment body be responsible for RPL assessment? 

Give details of how RPL assessment for the qualification will be carried out and quality 

assured. 

 

Yes. The RPL will be carried out through screening, identifying the skill gaps, provide bridge 

training to cover the competency gap & then conduct final assessments of the candidates. 

 

Describe the overall assessment strategy and specific arrangements which have been put 

in place to ensure that assessment is always valid, consistent and fair and show that 

these are in line with the requirements of the NSQF: 

 

The emphasis is on practical demonstration of skills & knowledge based on the performance 

criteria. Each OUTCOME is assessed & marked separately. Student is required to pass in all 

OUTCOMEs individually and marks are allotted. Following assessment methodologies are 

used. 

 

A. Written Assessment (Multiple Choice Questions) 

B. Practical Assessment 

C. Viva Voce Assessment 

 

The assessment results are backed by following evidences. 
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Please attach any documents giving further information about assessment and/or RPL. 

ASSESSMENT EVIDENCE 

Complete the grid for each component of NOS, assessment unit or other component as 

listed in “Formal structure of the qualification” in the summary. 

 

Title of Unit/Component: 
 

 
Outcomes to be 

assessed/NOSs to be assesed 

Assessment criteria for the outcome 

1. 
GettingKnowledge ofComputer 

Fundamentaland officeautomation 

software 

Learn basic concepts of Computer Fundamental 

Identify different concepts of Operating System and its 
functions 

Take necessary action how to use Office Automation 

Software 

2. Explain Concepts of Financial 

Accounting 

Prepare and Practice Financial Accounting 

Prepare and Practice Advance Financial Accounting 

3. To familiarize with Preparation 

of Account Books Using 

Accounting Packages 

Prepare Account Books Through Accounting Package 

Prepare Account Books Through Advance Accounting 

Package 

4. Develop Concept of Desktop 

Publishing Softwares 

Execute Advance Skills on Page Maker 

Execute Advance Skills on Photo Shop and Coral Draw 

 

 

 

 

Means of assessment 1 

 Sl Examination Pattern Modules Duration Maximum  

1 The assessor collects a copy of the attendance for the training done under the scheme. The 

attendance sheets are signed and stamped by the In charge / Head of the Training Centre. 

2 The assessor verifies the authenticity of the candidate by checking the photo ID card issued 

by the institute as well as any one Photo ID card issued by the Central/Government. The 

same is mentioned in the attendance sheet. 

3 The assessor assigns roll number. 

4 The assessor takes photograph of all the students along with the assessor standing in the 

middle and with the centre name/banner at the back as evidence. 
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 No  Covered in Minutes Marks  

 1 Theory Paper – 1 All modules 90 100  

 2 Practical -1 All modules 120 60  

 3 Internal Assessment All modules - 20  

 4 Assignment All modules - 20  

  Total   200  

Note: 
 

1. Pass percentage would be 50% marks in each component, with aggregate pass percentage 

of 50% and above. 

2. Grading will be as under: 

Grade S A B C D Fail 

Marks    
55%-

 

Range (in   >85% 75%-84% 65%-74% 
64% 

50%-54% <50% 

%) 

 

3. Theory examination would be conducted online and the paper comprise of MCQ and 

each question will carry 1 marks. 

4. Practical examination/Internal Assessment/ Project/Presentation/Assignment would be 

evaluated internally. 

5. Major Project/Dissertation would be evaluated preferably by External / Subject Expert 

including NIELIT Officials. 

6. Candidate may apply for re-examination within the validity of registration. 

7. The examinations would be conducted in English Language only. 

 

SECTION 2 

EVIDENCE OF LEVEL 

OPTION A 
Title/Name of qualification/component: Advance Diploma in Computer Application Accounting and 

PublishingLevel: 4 

NSQF Domain Outcomes of the 

Qualification/Component 

How the outcome relates to the 

NSQF level descriptors 

NSQF Level 

Process Individual afteracquiring the 

knowledge ofComputer 

fundamentaland office 
automationsoftwareis able 

to manage alloffice work 

throughcomputerIndividual 

Afteracquiring skillof 
FinancialAccountingand 

The mentioned activities are 
very routine and repetitive in 
nature and the scope of the 
same is very limited in context 
of the occupation . 

4 
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 AccountingPackages isable to 

prepareaccount books 

  

Professional 

Knowledge 
The candidateshould have the 
knowledge of allthe topics 

givenin thecurriculum in 

terms of theconcept as well 

as its practicalimplementation. 
Acquainted withcommon 

software toolsand process. 

Understand thecontext of 
workand trade at basiclevel. 

Familiarwith localspecific 

profession andbasic numeracy 
with literacyskills 

The job holder understands the 
basic facts , process and 
materials involved in his job role 
like tools required, equipment 
etc. 

4 

Professional 

Skill 
Handling ofappropriate 
software tools.Take adequate 

steps .Posses softskills 

required todeal 

withprofessionefficiently 

Limited service skills used in 
limited context; select and apply 
tools; assist in professional 
works with no variables; 
differentiate good and bad 
quality 

4 

Core Skill Individualshouldhavestrong 
technical,analyticaland 

problemsolving,skills.For 

updatingjobknowledgeby 
researching 

latestenhancements in 

thetechnologyandsoftware 

products.Candemonstrate 

routine,basicoperating 
tasksindependently 

Receive and transmit written 
and oral messages, basic 
arithmetic, personal financing, 
understanding of social, 
political, and religious diversity, 
hygiene and environment. 

4 

Responsibility Office Assistantsand 

TechnicalAssistants areable to 

deliverservices to any 
corporate officesas per their 

requirements 

Desktop 
Publisher are able 

to work with anyadvertising 

firmOR start their own 

businessAccountAssistants 
areable to work inaccount 

andfinancedepartment of any 

requirements.After acquiring 
skill of DesktopPublishing 

Softwares, individual is able to 

prepare anddesign pamphlet 
broachers. 

No responsibility; works under 
instruction and close 
supervision. 

4 

 

 

SECTION 3 

EVIDENCE OF NEED 



NSQC APPROVED 8 

Approved in 2nd NSQC – NCVET, Dated: 22nd September, 2020      

 

NSDA Code 
2020/ITES/NIELIT/03888 
 
 

 What evidence is there that the qualification is needed? 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
http://www.nasscom.in/indian-itbpo-industry 

 

The Indian IT-BPM sector continues to be one of the largest employers in the 

countrydirectly employing nearly 3.5 million professionals, adding over 2,30,000 

employees.Mr. R Chandrasekaran, Chairman, NASSCOM, said, “We are delighted 

with the robustgrowth demonstrated by the industry during the current fiscal year. 

The industry todayhas a very diverse landscape which is constantly evolving and 

fuelling growth for theindustry. Digital also became main stream during the year, 

with industry increasinglyinvesting in digitized solutions to drive future growth 

opportunities. Interestinglydigital solutions in the year accounted for 12-14% of the 

industry revenues.NASSCOM will continue to work with its members to build 

capabilities within thecountry and position India as an ideal global digital hub, 

leveraging technology fortransformation and driving innovation across domains.” 

The domestic IT-BPM market is rapidly approaching the USD 50 billion mark. In 

FY2015, the market is expected to be a little over USD 48 billion, an annual growth 

of714 per cent. This is faster than the average industry growth, and is largely being 

drivenby the booming eCommerce segment. Stable government with a technology 

focusedgrowth agenda is further boosting technology adoption in the domestic 

market“India is jumping the technology maturity curve and is emerging as a digital 

http://www.nasscom.in/indian-itbpo-industry
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economy.The recent announcements by the Government on Digital India, Make in 

India, Skilling India are creating a renewed thrust on the domestic market. 

NASSCOMwill continue to partners with diverse industry sectors and related 

governmentdepartments to enable technology adoption for key challenges faced by 

the country.”said Mr. R. Chandrashekhar, President, NASSCOM.In FY2016, 

NASSCOM expects the industry to add revenues of USD 20 billion to theexisting 

industry revenues of USD 146 billion. Export revenues for FY2016 isprojected to 

grow by 12 to 14% and reach USD 110-112 bn. Domestic revenues(including 

ecommerce) for the same period will grow at a rate of 15-17% percent andis 

expected to reach USD 55-57 billion during the year.Mr. BVR Mohan Reddy, Vice 

Chairman, NASSCOM said “The future looks verypromising as the IT-BPM 

industry is gearing itself well to next phase of challenges.Digitization, disruptive 

technologies and innovation will fuel growth with newopportunities in the years 

ahead. NASSCOM will work with its members to showcaseIndia as a destination of 

high value globalized solutions which are transformative andinnovative. The fast 

growing technology start-up sector will further drive innovation inthe country” 

Source:http://www.nasscom.in/robust-growth-indian-itbpm-industryIn FY2016, 

NASSCOM expects the industry to add revenues of USD 20 billion to theexisting 

industry revenues of USD 146 billion. Export revenues for FY2016 isprojected to 

grow by 12 to 14% and reach USD 110-112 bn. Domestic revenues(including 

ecommerce) for the same period will grow at a rate of 15-17% percent andis 

expected to reach USD 55-57 billion during the year. 

What steps were taken to ensure that the qualification(s) does/do not duplicate 

already existing or planned qualifications in the NSQF? 

Online access of Qualification Register is not yet available. 

What arrangements are in place to monitor and review the qualification(s)? 

What data will be used and at what point will the qualification(s) be revised or 

updated? 

The Qualification is to be monitored and reviewed every two years. 

The following data will be used 

1. Results of assessments 

2. Employer feedback will be sought post-placement 

3. Student feedbacks 

 

Please attach any documents giving further information about any of the topics above. 

NIL 

http://www.nasscom.in/robust-growth-indian-itbpm-industryIn
http://www.nasscom.in/robust-growth-indian-itbpm-industryIn
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What steps have been taken in the design of this or other qualifications to ensure that 

there is a clear path to other qualifications in this sector? 

 

This qualification has comprises both technical and analytic skills and can be linked to any 

qualification higher than this one, existing or to come. 

List any comparisons which have been established. 

NIL 

SECTION 4 

EVIDENCE OF PROGRESSION 
 

 

 

Please attach any documents giving further information about any of the topics above. 

Give details of the document(s) here: 

 

NA 

 

SECTION 5 

EVIDENCE OF INTERNATIONAL COMPARABILITY 
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Detailed Curriculum 

 

Name of Unit of 

Qualification 

: Understanding Computer fundamental and office 
automation software 

Duration : 50 Hours 

Topics : Computer Fundamental, Operating System, Office 
Automation 

 

Performance 

Criteria(OUTCOME) 

No. 

Contents Hrs. 

OUTCOME-1: 
Acquiring Skills to 
Understand 
Computer 
Fundamental 

Generation of computers, types of computers, 

micro, mini, main frame & super computers, 

applications, functional units & operation concepts. 

Memory Structure 

Basic concepts, types of memories from 

semiconductor RAMs, Memory system 

Considerations, ROMs, concepts of cache and 

virtual memory. 

Processor Unit 

Basic concepts, sequence of operations to execute a 

complete instruction, hardware control and micro 

programmed control-brief introduction. 

Secondary Storage 

Magnetic disk systems-floppy and hard disk - 

concept of disk operations-characteristics of 

different types of disk systems-magnetic tape 

systems-concept of optical storage devices. 

I/O Devices 

Various I/O devices-concept of video terminals- 

video displays-alphanumeric displays-graphic 

displays. 

Printers & Plotters 

Types-Specifications-Characteristics. 

05 

OUTCOME-2: 
Understanding 
Operating System and 
its functions 

Operating System: 
DOS 

Introduction, Different Operating Systems, Loading 

and Quitting the Operating Systems, Important 

DOS Commands (Internal and External), File and 

Directory System Concepts in DOS. 

WINDOWS 

Introduction Operating System 

Desktop icons 

My Computer, Recycle Bin, Internet Explorer, 

Network Neighbourhood, My Documents. 

Working with windows 

How to create a Folder, Copying and cutting files, 

Renaming. 

05 
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 Start icon 

Programs, Favorites, Documents, Settings, Find, 

Run, Shut down, application icons 

 

OUTCOME-3: 
Acquiring Skills to use 
Office Automation 
Software 

An introduction to word 

The Word workspace, Starting and quitting Word, 

Creating and Manipulating Various documents, 

Editing of proofing files, Merging documents and 

macros. 

How to use mouse and menu 

Working with dialog box. 

Primary commands in file menu 

The open command, The New command, The Save 

As and Save all commands, The Close command, 

The Page Setup, The Print Exit command. 

Edit menu commands 

The Cut, Copy and Paste commands, The Undo and 

Repeat commands. 

Format commands Font commands, Paragraph 

command. 

Other menu 

The View menu, The Inset menu, The Tools menu, 

The Table menu, The Window menu. 

Spread Sheet Preparation Using MS Office 

Building a simple worksheet 

Entering Text, Entering Values, Entering Dates and 

Times, Moving Around, Selecting Ranges, Using 

Menu, Using Tool Bar, Using Shortcut Menus, 

Changing entries, Copying entries, Moving Entries, 

Inserting and Deleting cells. 

Formatting Basics 

Changing Character Style, Changing Alignment, 

Changing Column Width. 

Working with Multiple worksheet 

Copying entries between work books, Moving 

sheets between work books, Deleting sheets, 

Quitting Excel. 

Opening existing workbooks 

Simple calculations. Doing Arithmetic, Totaling 

column of values, Naming cells and Ranges. 

Formatting Text 

Displaying dollars and cents, Formatting decimal 

places, Formatting dates, Copying style and 

formats. Formulas that make decisions — Using the 

IF function, Using the nested IF function, Copying 

formulas. Checking Spelling, Printing Worksheets, 

Preview Worksheets, Setting up the pages. Sorting 

data, Keeping Leading in View, Finding records, 

Adding and deleting Records, Filtering Records. 

Plotting charts, Sizing and moving charts, Updating 

40 
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 charts, Changing the chart type, Using chart auto 

format. Creating Macros, Recording Macros, 

Running Macros. 

Database Concepts Using MS Access 

Introduction to Database 

Database System Concepts, DBMS and RDBMS 

Planning and designing a database 

Creating a database — Sorting Data in Tables, 

Fields, Records, Two ways to Create a Database, 

Creating a Database with Database Wizard 

Building and Modifying Tables 

Create Tables by using the Table Wizard, Create 

Tables from Scratch, Field Names Data Types and 

Filed Properties, Modify Tables Using Design 

View, Entering Data in a Data sheet, Editing Data 

in a Datasheet, Changing the Width of Columns and 

Height of Rows, Changing the Order of Columns, 

Setting of Primary Key 

Defining Relationship 

Establish Relationship, Enforce Referential 

Integrity 

Querying a Database 

Constructing a Query, Creating the Query, Choose 

the Tables to Query, Field to Query, Entering the 

Query criteria, Saving the Results of a Query 

Different Kinds of Queries 

Crosstab, Update, Delete, Append, Make Table 

Building and Modifying Forms 

For Entering and Viewing Data, Creating a Form 

(Design View of Form Wizard), Use the Control 

Toolbox to Add Controls, Modify Format 

Properties (Font Style, Size, Color, Caption, etc.) of 

Controls, Use of Form Sections (Header, Footers 

and Detail), Use of Calculated Control on a Form. 

Slide Presentation Using MS Office 

Power Point 

Main Features of Power Point, Making the 

Presentation, Creating Template with the Auto 

Content Wizard. Creating a Presentation with a 

Template. Creating a presentation from Scratch 

Different Views 

Normal Slide, Outline, Slide Sorter, Slide Show, 

Notes, Slide Master Animation ,ART and Sound 

Controlling Transitions between slides. Animating 

Different Parts of a slide. Inserting a Motion Clip. 

Including Sounds in slides. Including Graphs, 

Charts, Tables and Columns Organization Chart 

Slide, Creating a table Slide. Creating two column 

Slide, Module 1: Showing A Presentation, 

Rehearsing/ Timing a Presentation, Designating 
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 some slides as ―Hidden, Viewing Slides 

Anywhere in a Slide Show. Techniques for Making 

a Show Livelier Office Connections Presenting 

with the help of other Office Programs Importing 

the text from a Word Document.— Printing a 

Presentation. 
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Name of Unit of 
Qualification 

: Introduction To Financial Accounting 

Duration : 50 Hours 

Topics : Financial Accounting 
 
 

Performance 

Criteria(OUTCOME) 

No. 

Contents Hrs. 

OUTCOME-1: 
Core Skills to Prepare 
Financial Accounting 

Introduction to Accounting 

What is Accounting, Financial Accounting Books 

of Accounts, Cash, Journal, General Ledger 

Classification of Accounts and Rules of Debits 

and Credit, Financial Statement, Trial Balance, 

Final Accounts Statements, O / S Bills Tracking 

Inventory Management 

Inventory Analysis, Depreciation, Delivering In 

& Out, Purchase & Sales Invoice, Debit & Credit 

Notes Foundation of Accounts, Ledger Accounts 

and Groups, Account Groups, Liability Side, 

Assets Side, Income Side, Expense Side 

20 

OUTCOME-2: 
Advance Skills to 
Prepare Financial 
Accounting 

Capital Account 

Capital, Reserves & Surplus (Retained Earnings) 

Loans (Liabilities), Bank overdraft, Secured 

Loans & Unsecured Loans Current Liabilities, 

Duties & Taxes, Provisions, Sundry Creditors, 

Current Liabilities 

Fixed Assets 

Investments Current Assets, Stock in Hand, 

Deposits (Assets), Loans & Advances (Assets), 

Sundry Debtors, Cash in hand, Bank Account 

Miscellaneous Expense & Suspense Account, 

Sales & Purchases, Direct & Indirect Income, 

Direct & Indirect Expenses 

Inventories 

Introduction Types of inventory, Inventory in 

case of manufacturing, Raw materials, Work-in- 

progress, Finished goods / stock, Inventory in 

case of trading concern, Finished goods / stock 

Basis of inventory valuation, Cost, Net realizable 

value Techniques of Inventory valuation, 

Historical cost methods, FIFO, LIFO, Average 

Price, Weighted average price, Non-Historical 

cost methods Inventory Record system, Periodic 

Inventory system, Perpetual inventory system 
. 

30 
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Name of Unit of 

Qualification 

:Preparation of Account Books Using Accounting 

Packages 

Duration : 50 Hours 

Topics : Prepare Account Books Through Accounting 

Package(Tally) 
 

 

Performance 

Criteria(OUTCO 

ME) No. 

Contents Hrs. 

OUTCOME-1: 

Acquiring The Skills 

To Prepare Account 

Books Through 

Accounting Package 

Tally 

Introduction to Tally, Tally Fundamentals, 

Features of Tally, Tally start up screen and 

components, Tally clock, Switching between 

screen area- Ctrl-n & Ctrl-m, Quitting Tally. 

Maintaining Company Data 

Basic Company Details, Creation, Modification, 

Tally – Accounting & Inventory, Chart of 

accounts – Group , Ledger, Introduction to F11- 

Features, Introduction to F12- Configurations, 

Maintaining stock details, Inventory Masters, 

Displaying and altering stock group, Creating 

and altering multiple stock categories, Creating 

and altering unit of measure. 

Tally Vouchers 

Accounting Vouchers, Contra Voucher (F4), 

Payment Voucher (F5), Receipt Voucher (F6), 

Journal Voucher (F7), Sales Voucher (F8), 

Credit note Voucher (Ctrl+F8), Purchase 

Voucher (F9), Debit note Voucher (Ctrl +F9), 

Reversing Journal (F10), Memo Voucher 

(Ctrl+F10), Optimal Voucher,Postdated 

Voucher, Inventory Vouchers, Inventory 

Vouchers, Purchase order, Sales order, Rejection 

out, Rejection In, Stock journal, Delivery Note, 

Receipt Note, Physical note, Invoicing. 

30 

OUTCOME-2: 

Acquiring The Skills 

To Prepare Account 

Books Through 

Accounting Package 

Display and Reporting 

Financial report, Financial Statutory Report, 

Balance sheet, Profit & Loss A/C, Trial Balance, 

Sales Register, Purchase Register, Journal 

Register, Cash Book, Bank Book and Ledger, 

Financial MIS Report, Group Summary, Group 

Vouchers, Statement of Accounts, Cost 

center,out    standings    ,    Interest   calculations 
,statistics, Inventory Report, Inventory  Statutory 

20 
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 Report, Inventory MIS Report. 

 

Technology Advantages of Tally, Tally Vault, 

Security control, Tally Audit, Backup and 

Restore, Split company data, Export and Import 

of data, ODBC Compliance Printing, New 

features in Tally 9, Value Added Tax (VAT), 

Tax Deduction at Source (TDS), Service Tax, 

Pay Roll Accounting. 
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Name of Unit of 
Qualification 

: Working with Desktop Publishing Softwares 

Duration : 50 Hours 

Topics :Page Maker, Photo Shop and Coral Draw 
 
 

Performance 

Criteria(OUTCOME) 

No. 

Contents Hrs. 

OUTCOME-1: 

Acquiring Skills on 

Page Maker 

Page Maker 

Introduction to Desktop Publishing, Introduction 

to PageMaker Advantages, Using the Mouse, 

Components of the PageMaker Window. Setting 

the Margins, Setting the Page Size, Changing the 

page Orientation, Setting Page Numbers, 

Changing the Page Size view, Creating New 

Document Windows: Displaying the Rulers, 

Changing the Rulers, Using Rulers, Using 

Guidelines, Positioning Guidelines, Adding 

Guidelines to Master Pages. Aligning to 

Guidelines, Displaying Guidelines, Locking 

Guidelines. Formatting Types: Changing Fort 

Families, Changing Font Sizes, Changing 

Typeface Style, Changing Character 

Specification: Changing Type leading, Changing 

Character Widths, Changing Tracking, Changing 

Type Options. Saving Your Document: Saving a 

new Documents, Saving an existing Document, 

Saving a Document as another document, 

Reverting to a Previously Saved Version. 

Developing Paragraphs: Typing Text, Adding 

special Characters to Text, Aligning Text. 

Formatting Paragraphs: Changing Indents, 

Changing the space around Paragraphs, 

Changing Paragraph Alignment, Controlling 

How Paragraphs Break Between Pages and 

Columns, Adding lines Above or Below Your 

Paragraphs. Converting Other Objects to 

Frames, Threading and Unthreading Text. 

Threading additional Text, Threading Text to 

Different Page. Unthreading Text Blocks, 

Rethreading Text Blocks, Making Text Blocks 

Disappear Without Deleting them, Selecting and 

Dragging Text, Editing Deleting Text, Cut, 

Copying, Pasting Text, Viewing the Contents of 

Clipboard, Using Undo and Revert. Inserting 

and  Removing  Pages:  Inserting  and Removing 
Pages, Adjusting Spacing of Characters,  Words, 

20 
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 Lines: Adjusting, Spacing and Leading, Setting 

and changing Tabs. Introduction to Auto Flow, 

PageMaker Plug-Ins, Drop Cap, Change Case, 

Bullets and Numbering. Adding Design 

Elements – Introduction Adding Graphics to 

your Documents, Adding Lines, Changing Lines 

Specifications, Adding Shapes, Changing Shape 

Specifications, Changing Line and fill, 

Specifications together (fill and Stroke), 

Changing Round Corners, Creating Drop- 

Shadow, Boxes, Text wrap, Changing 

PageMaker Options: Adjusting Margins, Setting 

and Adjusting Columns, Setting Unequal Width 

Columns, Creating headers and Footers, 

Creating Graphics in PageMaker, Rotating Text, 

Skewing and Mirroring objects with Control 

Palette. Importing Graphics into PageMaker: 

Placing, aligning Graphics, Cropping Graphics. 

Setting up Templates Setting Up Master Page 

Templates, Creating Custom Page Sizes, 

Creating Custom Borders, Creating a News 

Paper Template, Creating New master Pages, 

Saving an existing Page As a Master Page. 

Setting UP Custom Styles: Defining Styles, 

Creating, Editing, Removing Styles and Copying 

Styles. Introduction to Using layers, n-Layers 

Palette, Moving and creating objects. 

Introduction to Printing – Selecting a Printer 

Printing your Document, Printing Document 

Dialog Box Options. Adding Color  Introduction 

– Using PageMaker Default Color Palette, 

Opening Color Palette, Adding color to Text, 

Working with Color Graphics, Defining Custom 

Colors, Creating Text Screens. Developing Long 

Documents Introduction – Using Story Editor: 

Opening Story Editor, How the Story Editor 

names, Tories, Switching Between Story Editor 

and Layout Editors, Closing Story Editor and 

Placing the Story Editor, Differences between 

Story Editor and layout Editors. Spellings 

Starting the speller, Correcting Misspelled 

Words, Correcting Duplicate Words, Adding 

Words to the different Dictionaries, Correcting 

Duplicate Words, using  find Feature,  Using the 

change Feature, Creating an Index, using 

PageMaker Help. 
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OUTCOME-2: 

Acquiring Skills on 

Photo Shop and Coral 

Draw 

PHOTOSHOP 

Elements of Photoshop, The Elements 

Environment, Exploring the Photoshop Elements 

Work Area, Basic Tools and Palettes Modifying 

an Image, Making Minor Adjustments to your 

Image, Adjusting the Lighting in Your Image 

Enhancing an Image, Enhancing an Image with 

Text, Enhancing an Image with the Painting 

Tools, Enhancing an Image with Layer Effects, 

Enhancing an Image with Filters Composite 

Images, Creating a Composite Image, Create an 

Animated GIF, Creating Composite Images 

using Photo merge The Finished Product, Saving 

Images for the Web and Creating a Web Gallery, 

Photoshop Elements Print Options 

CORELDRAW 

Basics of CorelDraw Introduction, Getting 

Started, Creating A New File, Title Bar, Work 

Area, Printable Page, Property Bar, Page 

Counter Bar,Color Palette, Toolbox, Statues Bar, 

Drawing Figures, Lines, Ellipse, Circles, 

Rectangle, Square, Polygon, Saving, Closing, 

Opening, Views, Normal View, Preview, Wire 

Frame View, Draft View, ZoomView Manager, 

Creating View Drawing Introduction, Toolbox, 

Selecting an Object, Resizing an Object, 

Moving, Moving An Object, Changing the 

Shape, Combining Two Objects, Skewing, 

Welding the Objects, Blending, Curve Lines, 

Straight LinesContinuing a Line,View Mode, 

Changing, Media Tool Rotating An Object, 

Grouping-Fill Tool Fly OutFilling, Spray Mode. 

Text Introduction, Text Tool, Entering Artistic 

Text, Entering Paragraph Text, Converting Text, 

Formatting Text, Changing the Font Size, 

Arranging Objects, Ordering the objects, 

Changing the Font, Bullets, Decorating the Text, 

Welding, Text Editor, Opening, Changing the 

Alignment, Type Style, Spell Checking, 

Grammar Searching Synonyms, Find, Replace, 

Editing, Kerning, Formatting Characters. 

Images Bitmap Images, Vector Images, 

Resizing, Rotating, Skewing, Moving, Cropping, 

Importing Images, Adding Special Effects, 

Converting to Bitmap, Exporting Images. Page 

Layout Changing the Page Size, Changing the 

Layout, Applying Styles, Applying Bitmaps to 

the Background, Changing the Background, 

Adding a Page Frame, Moving Between Pages. 

30 
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